
Not long to go now…  Just a reminder, this 30+ hour virtual conference, 
for charity, presents many Excel, Data Platform and PowerPoint MVPs, 
together with other acknowledged experts from Microsoft and / or 
around the globe to present, answer questions and demonstrate the 
future of Excel and how it will make your life easier, personally and 
professionally.

Topics will include all things Excel, financial modelling, dynamic arrays, 
Power Pivot, Power Query and Power BI.  It’s not all in English either, with 
some sessions in Portuguese and Spanish too (at the time of writing).

Each session (including Q&A) will last no more than an hour and topics 
will cover all expertise levels, from novice to expert.  Most presenters are 
well known in their spheres, and have written blogs, books and articles 
and / or present video sessions.

Most sessions will be recorded so you may watch them later with 
downloads aplenty – there are no medals for staying up to watch the 
entire event live!  That’s just as well, as it will run from midnight GMT 
/ UTC on Monday 17 October into some time on Tuesday 18 October.  

From your own favourite chair, bring a laptop, an inquisitive mind and 
your sense of humour.  Be prepared to learn heaps.  And remember, 
it's for charity – this year, there is no ticketing process: all we ask is an 
“honesty box” where you donate to your favourite charity.

For more details (e.g. times, speakers, sessions), please go to  
www.excelvirtuallyglobal.com.  The links will go live nearer the time, so 
keep checking back as the program may change too.

Hopefully, we’ll see you there!

NEWSLETTER #119 - October 2022

contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

www.sumproduct.com  |  www.sumproduct.com/thought

Liam Bastick, Managing Director, SumProduct

Excel Virtually Global 2022

Excel Virtually Global 2022 is almost upon us 
Have you checked out the website yet?  If not, read all about it (below).

Power Query gets another step closer with Excel for Mac and we fill you in on this important update below too, together with Excel’s new 
IMAGE function.  

As always, that’s not all.  

We also bring you another Beat the Boredom Challenge to keep you on your toes, together with Charts & Dashboards, Visual Basics, 
Power Pivot Principles, Power Query Pointers, Power BI Updates and Keyboard Shortcuts.  Our A to Z of Excel 
Functions also details several key functions we use everyday in our work (such as INFO – er, maybe not – but INDEX 
and INDIRECT are certainly key topics for any modeller looking to make the most of their toolset).

As always, happy reading and remember: stay safe, stay happy, stay healthy.
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This feature is available to Insiders using either the Current Channel 
Preview or Beta Channel, running Version 16.64 (Build 22072501) or 
later.  When we previously mentioned this back in the June newsletter, it 
was only available to Insiders on the Beta Channel.

When Power Query was first released in Excel for Mac, there was hope 
that it wouldn’t take long for the features to mirror their Window 
counterparts.  It’s taking time, but the capabilities are improving.  
Beginning with the ability to refresh data two years ago, importing data 
was introduced this time last year, so this does seem to be an annual 

event!  As you may imagine, Mac users have desperately requested the 
ability to transform data using the Query Editor, which would provide 
users with the full Power Query experience in Excel for Mac.

Well… it’s getting there!  You may now clean and shape your data with 
hundreds of transformations available in Power Query Editor in Excel for 
Mac. 

To access, on the Data tab, click the Get Data (Power Query) button.

Click Launch Power Query Editor to open the Query Editor.

You can shape and transform your data using the Query Editor similarly to Excel for Windows.  When you’re done, click the ‘Close & Load’ button on 
the Home tab.

Shaping Data with the Power Query Editor in Excel for Mac
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 The newly imported data appears in a new sheet.  

Supported data sources include:

	 •	 text, CSV, XLSX, XML and JSON files
	 •	 SharePoint, SharePoint Lists, SharePoint Folders and OData
	 •	 local tables, Tables and ranges
	 •	Microsoft SQL Server.

You may also access the Query Editor from the data import flow by clicking the Get Data (Power Query) button, choosing a data source, and clicking 
the Next button.

With many of us currently “working from home” / quarantined, there are 
only so Zoom / Teams calls and virtual parties you can make before you 
reach your (data) limit.  Perhaps they should measure data allowance 
in blood pressure millimetres of mercury (mmHg).  To try and keep our 

readers engaged, we will continue to reproduce some of our popular Final 
Friday Fix challenges from yesteryear in this and upcoming newsletters.  
One suggested solution may be found later in this newsletter.  Here’s this 
month’s…

…eno siht rof esrever otni niarb ruoy tup ot deen thgim uoY

Beat the Boredom Challenge
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Nearly two years ago, the Microsoft Research Blog discussed LAMBDA. Highlighting the power of this Office 365 function, they wrote the following:

Aside from the fact that there is a mistake in the formula for REVERSE, having one too many closed brackets (they really should use FORMULATEXT!), 
the Research Team has erroneously stated that “…reversing a string is beyond the built-in functions of Excel and could only previously (sic) be written 
outside the formula language…”.

Spurred on by several of our readers, we vehemently disagree; so here’s this month’s challenge:

For all current versions of Excel (not just Office 365, Excel on the web and Insider / Beta variants), write a formula that will reverse the text in a cell 
(i.e. reverse the text string).  You cannot use VBA, dynamic arrays, JavaScript, TypeScript or Office Scripts. 

Sound easy?  Try it.  One solution just might be found later in this newsletter – but no reading ahead!  

It’s time to chart our progress with an introductory series into the world of creating charts and dashboards in Excel.  This month, we look at PivotCharts.

PivotCharts are complementary visual representations of data in 
PivotTables.  They display any data currently in a PivotTable in a chart, 
with that they also inherit the flexibility and interactivity of PivotTables.  

When a PivotChart is created, it will inherit the filters and sort abilities 
that are also available in the associated PivotTable.  Changes made in the 

PivotChart will also be reflected in the PivotTable and vice versa.

The key benefit for a PivotChart is that it is able to summarise raw data or 
tabular data, i.e. data that has not been analysed whatsoever.  We would 
be able to use a PivotChart just as we would a PivotTable to analyse data.

Below are a few differences between PivotCharts and ordinary charts:

	 •	 row / column orientation: switching the rows and columns around in a PivotChart cannot be performed through the ‘Switch Row / Column’ 	
		  button on the Ribbon

	 	 It has to be undertaken through switching the fields from the Rows and Columns area in the PivotChart Fields pane

	 •	Chart Type limitations: PivotCharts cannot be produced for XY (scatter charts), Stock or Bubble charts

	 •	 source data: PivotCharts draw data from their underlying PivotTable’s data source, whereas standard charts are linked directly to worksheet cells

	 •	 formatting: most formatting elements in a PivotChart are preserved when a PivotChart is refreshed.  However, do be wary that trendlines, 	
	 	 error bars, trendlines and changes to data sets are not preserved.

Let’s move on to an example.  Imagine creating a Bar chart with the following data:

Charts and Dashboards
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We may create the following chart with the data above:

Let’s try again with a PivotChart.  To create a PivotChart, highlight all the data and go to Insert –> PivotChart –> PivotChart & PivotTable.

A ‘Create PivotTable’ dialog will appear.  Here, we may choose where to place the PivotTable report, either into a new worksheet or in the 
existing worksheet.  In this example, the PivotTable report will be loaded to cell F63 in the current worksheet:

Clicking OK allows the PivotChart interface to be loaded:
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Dragging the fields to appropriate areas will result in an initial PivotChart and PivotTable being displayed:

The PivotChart is able to produce a visual that readily summarises the data in an easily understandable way with few manual adjustments.

PivotCharts allow interactivity within the chart.  For example, we may apply filters to the data by clicking on the downwards arrow next to ‘Year’ and 
‘Country’ fields:
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These filters will also apply to the PivotTable linked to the PivotChart.  
For example, if we choose to see only Australia’s and Canada’s sales 
in three most recent years reported (2017, 2018 and 2019), both the 

PivotChart and the related PivotTable are adjusted based upon the new 
filters.  Further, note the filter icons in the ‘Year’ and ‘Country’ fields of 
PivotChart and PivotTable:

More next month…
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We thought we’d run an elementary series going through the rudiments of Visual Basic for Applications (VBA) as a springboard for newer users.  What 
should we ‘Do’ this month?

In last month’s newsletter, we While Wend-ed down a loopy path, but now it is time to find better things to Do.  Do...Loop loops are considered the 
upgraded alternative to While Wend.  Let’s have a look at how they work:

So how would the code change from a While Wend to a Do…Loop ?  Simply replace the While with Do While and Wend with Loop.

For one thing, While Wend has no ability to have an Exit.  Let’s return 
to our Jack and Jill example.  What if the hill has five [5] steps?  The 
condition for the loop could be altered to check CurrentStepsTaken 
before entering, but the Do...Loop has the flexibility to break out with an 

Exit statement.  Here, the subroutine can check if Jack and Jill fall down 
after they take a step. I f they don’t fall down when they reach the top 
of the hill, then the print statements need to be changed accordingly:

Do...Loop is superior to While Wend for a multitude of reasons.

Do [{ While |Until } condition ]

[ statements ]

[ Exit Do ]

[ statements]

Loop

Visual Basics
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Sub JackAndJillExit()

Dim CurrentStepsTaken As Integer

CurrentStepsTaken = 0

Dim FallenDown As Boolean

FallenDown = False

Do While FallenDown = False

    CurrentStepsTaken = CurrentStepsTaken + 1

    If Rnd() <= 0.3 Then

        FallenDown = True

    End If

    If CurrentStepsTaken = 5 Then

        Exit Do

    End If

Loop

Debug.Print CurrentStepsTaken & " step(s) up the hill were taken."

If FallenDown Then

    Debug.Print "Jack fell down the hill!"

    Debug.Print "Jill came tumbling after..."

Else

    Debug.Print "Jack & Jill reached the top of the hill!"

End If

End Sub

Do 

[ statements ]

[ Exit Do ]

[ statements]

Loop [{ While |Until } condition ]

This provides the following result:

They didn't fall down when they reached the top, but because they had 
reached the top, we asked the program to exit as reaching the top was 
not part of our loop conditional expression.

The second reason that Do…Loop is superior is that While Wend loops 
check for the condition prior to running, whereas with Do…Loop the 
condition may be checked at the end.  So you might be thinking, why 

would you want to test the condition at the end?  

For an example, let’s consider Jack and Jill will always take at least one 
step onto the hill before falling.  They won't fall if they haven't moved!  
How this is written in code is by simply moving the “While condition” 
part of the Do statement next to Loop.  The syntax changes to:
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This will execute the statements within the loop to run at least once, 
before checking the condition and exiting if applicable.

Imagine we have Jack and Jill sitting pretty on the top of the hill having 
already taken five steps.  Let’s set them on a loop walking, despite having 
reached the top:

The third and final reason consideration of Do…Loop being superior to 
While Wend is that we have the option of Until.  What effect does this 
achieve?  This essentially reverses the value of the condition to be tested. 

While executes the block of code when the condition is true and keeps 
executing that until the condition becomes false.  Once the condition 
becomes false, the loop is terminated.  Until does the opposite.  It 
executes the block of code when the condition is false and keep 
executing that until the condition becomes true.  Again, once the 
condition becomes true, the until loop is terminated.

In our Jack and Jill example, the condition is that Jack and Jill have not 
fallen down.  Our variable that determines that FallenDown = False in 
order to use Do While.  Knowing that changing the keyword While to 
Until essentially flips the Boolean test condition requirement, we would 
simply check against the condition FallenDown = True.  However, do note 
that our FallenDown variable is already a Boolean type.  We don't even 
need to use the condition FallenDown = True because it is superfluous.  
We can convert our original loop as follows:

This results in:

More next time.

Sub DoItAtLeastOnce()

Dim CurrentStepsTaken As Integer

CurrentStepsTaken = 5

Do

    CurrentStepsTaken = CurrentStepsTaken + 1

Loop While CurrentStepsTaken < 5

Debug.Print CurrentStepsTaken & " steps were taken."

End Sub

We continue our series on the Excel COM add-in, Power Pivot.  This month, we consider how to stop the CALCULATE function from overwriting 
row filters.

Let’s say we wish to create a measure to calculate the total sales of all products classified as Product Category 2. 

Power Pivot Principles
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Let’s try this with the CALCULATE function:

=CALCULATE(
		  [Sales],
		  'Product SubCategory'[ProductCategoryKey] = 2
)

The Only Category 2 measure yields:

In this case, the CALCULATE measure overrides the row context in cells C4:C7 to be ProductCategoryKey = 2 instead of their respective values (i.e. 1, 
2, 3 or 4).  Let’s try adding the VALUES function into a measure:

=CALCULATE(
	 [Sales],
	 FILTER(	
				    VALUES( 'Product SubCategory'[ProductCategoryKey]),
				    'Product SubCategory'[ProductCategoryKey] = 2
	 )
)

mailto:contact@sumproduct.com
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This measure yields:

Voilà!  Using the VALUES function we have managed to alter the CALCULATE function’s behaviour and stop it from overriding the row context values.  
Our data no longer has the same values for each Product Category!

More Power Pivot Principles next month.

Each month we’ll reproduce one of our articles on Power Query (Excel 2010 and 2013) / Get & Transform (Office 365, Excel 2016 and 2019) from  
www.sumproduct.com/blog.  If you wish to read more in the meantime, simply check out our Blog section each Wednesday.  This month, we look at 
a more comprehensive way to convert a check box into a name.

Continuing last newsletter’s topic, the aim here is to take the table below and transform it into a more useful layout.

We will be using the same simple table showing the usual imaginary salespeople and the benefits they may access.  Let’s have the same goal as last 
month; we want to end up with the layout below:

Power Query Pointers
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Last time, we looked at a way to achieve this on a small scale, by adding 
new columns.  This time, we will look at a more complex version that will 
work for any number of columns. 

In order to construct my table in the format that is required, let’s first 
break it up into its constituent parts, that is, the Salesperson Name 
and Benefit types (i.e. a list of all the headings).  We will also create a 

list of pairings between salespeople and benefits received.  Finally, we 
can recreate the table, not forgetting that we will also need to show 
which benefits are not received (this is particularly appropriate for poor 
‘NewGuy’!).

Let’s create a query using ‘From Table’ on the ‘Get and Transform’ 
section of the ‘Data’ tab:

The first step is to obtain a list of salespeople, so select the Name column 
and choose to ‘Remove other Columns’ from the ‘Remove Columns’ 
dropdown in the ‘Manage Columns’ section on the ‘Home’ tab.  Note 

that in most cases, the functions used in this example are also available 
by right-clicking on the appropriate column.

We have our first query, which we will call ‘Salespeople’.

Save this query as a ‘Connection Only’, since we will be using it to build the final query.
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Now we require the next part of the data: a list of pairs to show each benefit a salesperson receives.  Let’s start the query in the same way as before 
from the table, but this time we will need to unpivot the data.  On the ‘Transform’ tab, having selected the Name column, we may choose to ‘Unpivot 
Other Columns’ from the ‘Unpivot Columns’ drop down in the ‘Any Column’ section.

This gives us a list of salespeople and each benefit they receive.  Note that ‘NewGuy’ is not shown because no values existed in the unpivoted columns 
for them.  All the null cells, which had no ‘x’ in them, have been removed as part of the unpivoting process. 

We may now delete the Value column and rename the query (Salespeople_vs_Benefits), which we will also ‘Close & Load’ to ‘Connection Only’.
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Thus, we have a list of salespeople and a list of benefits that each salesperson receives.  We’re now going to construct a list of the benefits that are 
available.  Let’s start again from the original table, and unpivot everything except the name once more.

This time, we’re going to only keep the Attribute column, and ‘Remove Duplicates’ from ‘Remove Rows’ dropdown on the ‘Home Menu’, viz.

We now have a list of benefits, which we’ll also save as a ‘Connection Only’.  Let’s call this query ‘Benefits’.
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Now we have our building blocks; we may now create our final query.

Let’s start with our ‘Benefits’ query.  We need to pull the salespeople 
back into this query, so we shall add a custom column.  The method we’ll 
use is a cross join, which we have discussed in a previous newsletter.

Let’s add a ‘Custom Column’ from the ‘Add Column’ tab.  It’s good to 
open the Query pane to the left of the screen so that you may see the 
names our other queries, viz.

We’ll add the salespeople first, so let’s use the ‘Salespeople’ query:

This initially gives us a table in each row.
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This initially gives us a table in each row.

We can expand the table using the icon next to the column heading.

Presumably, the salespeople would like this (especially NewGuy!), but the data now shows all the possible combinations available.  We need to 
change this to show those that are actually received!

Let’s start to get our data ready to resemble the table I want by putting Name first and sorting on Name.
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We’ll save this query as ‘Available_Benefits’.  Next, we are going to create a new query by merging some of our existing queries.

We’ll access the Merge option by right-clicking on the ‘Available_
Benefits’ query.  We want to merge ‘Available_Benefits’ with 
‘Salespeople_vs_Benefits’, linking all the possible benefits to the ones 

that are actually received.  This will allow us to keep ‘NewGuy’, as he is in 
the ‘Available_Benefits’ table.

We wish to join by matching both of our columns, and we need to 
include everyone in the first query (so that ‘NewGuy’ doesn’t get left 
behind) and all the data in the second query (as that tells us who gets 

the benefits).  Let’s choose a ‘Full Outer’ join, combining all the available 
data from both tables:
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We may expand the Salespeople_vs_Benefits column to show all the columns in that table.

Now you can see that we’re starting to get the data in the format we’d 
like.  We just need to remove the Name column and pivot the Benefit 
column so that they become the headings.  We may do this by selecting 

the Benefit column and choosing the ‘Pivot’ option in the ‘Any Column’ 
section of the Transform tab.

The values need to come from the Attributes column, as that holds the logic for the benefits, and we don’t want Power Query to apply any aggregation.
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Our results are now looking good!

We may now load this data to our worksheet:

Finally, we want to see what happens if we add a new benefit and refresh our query.
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A new bonus scheme has arrived, but not everyone is eligible!  Let’s refresh the query.

Derek, John and Mary are clearly on the bonus scheme.  As we have broken the query down and reconstructed it, any changes to benefits or staff 
will be reflected when refreshed.

More next month.

As always, there is yet another variety of new features.  This month’s updates include features such as an hierarchical axis by default, translations for 
composite models, mobile formatting options in General Availability and cross tenants’ datasets sharing.  The full list is as follows:

Power BI Updates

Reporting

	 •	Hierarchical axis by default
	 •	 Improved display name for summarised fields
	 •	Conditional formatting for data labels
	 •	 Translations support for Composite models on Power BI Datasets 	
	 	 and Analysis Services in Preview
	 •	Mobile formatting options now Generally Available
	 •	 Information protection update

Data connectivity and preparation

	 •	Dremio (Connector Update)
	 •	 Profisee (New Connector)
	 •	 Starburst Enterprise (Connector Update)

Service

	 •	 Cross-tenant dataset sharing in Preview
	 •	Auto-generate reports on existing datasets
	 •	Discoverability feature for B2B content

Mobile applications

	 •	 Power BI fonts now available on mobile devices (iOS and Android)
	 •	Windows app: upgraded browsing experience with WebView2

Embedded Analytics

•	 Power BI component for Vue.js
•	 Power BI and Jupyter integration updates 	
	 (delayed until October 2022)
•	 Export paginated reports by a service principal with a Power BI 	 	
	 dataset as a data source
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Visualisations

	 •	New visuals in AppSource
	 •	 Shielded HTML Viewer by Nova Silva
	 •	Drill Down Combo PRO by ZoomCharts
	 •	 Intelligent Narratives by Arria NLG

Other

	 •	 Paginated reports data Preview.

Let’s now go through each in turn.

One of Power BI’s Cartesian charts’ more useful capabilities is the option to visualise multiple categorical fields in an hierarchical x-axis.

The grouped x-axis is an organised way to add an additional dimension to the data in your charts, especially when dealing with subcategories that 
are specific to individual category fields or sequential subcategories such as more granular dates.

Hierarchical axis by default
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A different form of visualising these additional dimensions, like using a 
legend or small multiples, would not be nearly as clear as the hierarchical 
x-axis.  However, before this release, formatting a chart to use the 
hierarchical x-axis was a multi-step process involving:

	 •	 adding a new field to the X-axis field well and knowing to expand 	
		  the visual down to the next level, or else nothing would change

	 •	 turning off the concatenate labels option in the Formatting pane, 	
		  which would often still result in nothing happening because the 	
		  user also had to sort the visual by the axis fields rather than by 		
		  value fields, otherwise categories and subcategories would not be 	
		  grouped properly.

This latest update adjusts the behaviour to ensure that the hierarchy 
axis is automatically turned on when a user drags multiple fields into the 
x-axis field well of charts which support the feature.  Also, Microsoft has 
turned the concatenate labels option off by default in the Formatting 

pane.  Power BI will now auto-expand charts down to the bottom of the 
hierarchy when you add fields to the x-axis field well and will also sort on 
category by default once you drill down. 

The exact changes in logic are as follows:

This only changes how Power BI responds to authoring actions, so existing 
reports should not be affected, and you should be able to recreate any 
previous sort or expand state after this release as well.

It is understood that adding new conditions to default behaviour will 

create some inconsistencies in what happens when you perform an 
action.  That said, Microsoft hopes that they will feel intuitive as you 
create new charts and that they will save you clicks, Formatting pane 
navigation and internet troubleshooting.

Behaviour Defaults before update Defaults after update

Concatenate labels option On by default Off by default

Adding new fields to the x-axis field well Adding new fields will not change which 
fields are shown on the visual (user must 
manually expand all)

Expand to lowest level when:

	 •	 the visual supports hierarchy axis

	 •	 the axis is a categorical or datetime 	
		  axis (note that numerical fields be		
		  come categorical when they’re not 	
		  the top level of a hierarchy)

Sort behaviour Sort by measure when the user has not 
explicitly set a sort

Sort by category when:

	 •	 the visual supports hierarchy axis
	 •	 when the visual is expanded down in 	
		  any way
	 •	 user has not explicitly set a sort
	 •	 an authoring action is taken (like 		
		  adding or removing a field; notably, 	
		  not manually expanding the visual)

Otherwise, sort by measure (or by user-
set sort).

To improve comprehension for end users and new creators, this update sees the display name for summarised (summarized) fields to include the 
default or selected aggregation:

Improved display name for summarised fields
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Previously, default aggregates would be dropped from the display name, 
and this applies to all aggregates not just the ‘sum’ aggregation.  This is in 
response to the fact that it has been noted that dropping the aggregate 
leads to users misinterpreting what aggregate is being applied, if any.

For example, in the table (below), the Sales and Unit Price columns do 
not indicate to users how they are being aggregated.  This may cause 
users to think both columns have a sum aggregation applied, which is not 
correct for the Unit Price column.

This improvement will be available on all new reports by default.  If you 
want to enable this behaviour for existing reports, you can navigate to 
File -> Options and settings -> Options -> Default summarization and 

enable the setting: For aggregated fields, always show the default 
summarization type.
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Last month, Microsoft released an update to conditional formatting for data labels.  This allowed them to apply to each individual data point rather 
than all of them together.  At the time, this improvement was limited to visuals without a field in the Legend field well.  Now, this update has brought 
that same behaviour to those cases as well.

This month sees translations now supported for composite models on 
Power BI datasets and Analysis Services.  Translations enable you to 
show the tables and columns in your dataset in the language the end 
user prefers.  Up until now, if the source had any translations defined, 
they would be ignored when building a composite model on Power BI 
datasets or an Analysis Services model.

However, starting with this release, any translations defined in the 
source will be exposed in the composite model as well so the table and 
column names will be translated to the user’s language, the same as in 
the source datasets.

You can also add translations in your composite model and to make sure 
your local translations are not overwritten by the translations defined 
in the source, you can set the ‘Altered’ property on the corresponding 
object to ‘true’.  If you currently have translations defined in your 
composite model, Power BI will set the ‘Altered’ property automatically 
once you open the model in this month’s Desktop release.  In addition, 
you can use external tools to accomplish the same effect.

Mobile formatting options are now Generally Available.  These options allow you to style and format visuals in mobile-optimised layout without 
affecting their formatting in web layout.  This gives you greater flexibility and opens up a world of design possibilities for creating reports better 
optimised for phone viewing.

Since this interaction has now been improved, Microsoft has returned the conditional formatting button to the Formatting pane (yay!) for visuals with 
legend fields.  Keep in mind that the conditional formatting rules for data labels that you’ve already set on current reports will still not be affected 
until you reapply the rule and publish the report again.

Conditional formatting for data labels

Translations support for Composite models on Power BI Datasets and Analysis Services in Preview

Mobile formatting options now Generally Available
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Using Power BI Desktop, you can build reports on a dataset in the 
Power BI service by creating a live connection to a dataset using either 
a connection string or the Get Data experience.  If the dataset has a 

sensitivity label, Power BI will automatically apply the live dataset’s 
sensitivity label to the PBIX file to maintain the data’s classification and 
protection as it leaves the Power BI Service.

The Dremio connectors have been updated.  This release contains a fix to provide more accurate error reporting when a connection error occurs.  It 
also contains a fix that prevents Dremio Software from displaying virtual datasets (VDSs) in reports in some cases.

The Profisee Connector for Power BI makes it easy to access clean, 
complete and accurate data to help organisations accelerate both 
operationalised Business Intelligence and ad hoc analytics — even if they 
aren’t familiar with master data management (MDM) or the Profisee 

platform.  With just a few clicks, users may load data into Power BI from 
Profisee, allowing them to easily model and leverage data directly in 
Power BI.

The Starburst Enterprise connector has been updated.  It has now added:

	 •	 support for new authentication methods using OAuth 2.0 Personal Access Token (JWT)
	 •	 support for advanced filtering with the built-in regular expression filtering feature in Power BI Desktop
	 •	 an optional Catalog field in the connection dialog.  Selecting a catalogue with this field reduces the amount of metadata fetched from the 	
		  cluster
	 •	 an optional safe metadata read field in connection dialog.  When enabled, queries will not fail on faulty catalogues, but performance will be 	
		  slower (by default, this option is disabled).

The new cross-tenant dataset sharing capability is now available in 
public Preview.  This capability allows customers to share their Power BI 
datasets with external users in a way that allows these them to access 
the datasets in their own Power BI tenant.  This is in-place sharing, 
meaning that from their own tenant, users may discover and connect to 
live data from providers.  They can then work with these shared datasets 
in their own tenant and create composite models by meshing the shared 
datasets with their own internal data.  The composite model may then 
be published on the Power BI Service for reporting purposes.

With in-place sharing, the shared data remains in the provider tenant.  
Users query the shared datasets directly in the source data systems.  
Also, they can connect to external datasets using the Direct Query 

method and build their own composite models and reports on top of the 
shared data, eliminating the need to manually transfer data between 
organisations.  These composite models built on top of external datasets 
may also be analysed in Excel.  This capability is particularly useful when 
you want to share data with external partners, customers, subsidiaries, 
vendors, consultants and other business partners. 

Recognising the need to provide governance over external sharing, the 
dataset sharing capability has two tenant settings that enable Power BI 
administrators either to disable cross-tenant data sharing entirely or to 
control which users and / or user groups are allowed to share datasets 
across tenants.  These controls enable organisations to better manage 
dataset access and sharing in line with their data policies.

Information protection update

Dremio (Connector Update)

Profisee (New Connector)

Starburst Enterprise (Connector Update)

Cross-tenant dataset sharing in Preview
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When external data sharing is enabled, to initiate dataset sharing with 
external users, the specified dataset owners need to go to the settings 
of the specific dataset to be shared and enable external sharing there  

(see below).  This provides additional granular control over which 
datasets can or cannot be shared externally.

Once external sharing is enabled in the dataset settings, data providers 
may share the datasets externally just as they would with internal 
users.  External users need to have a registered Azure Active Directory 

(Azure AD) guest account in the provider tenant for them to be able to 
access the shared datasets.  The external users may then discover these 
datasets in Power BI Desktop, viz.

External users can connect to the external dataset and then build 
composite models by adding either other external datasets or their own 
internal datasets.  These new datasets may then be published to the 
Power BI Service.  Once published, the external users can access the new 

datasets in the Power BI Service in their own tenant and build further 
reporting on top of them.  These reports can be shared with other 
users in their own organisation, provided that those users also have the 
requisite Azure AD guest credentials on the original provider tenant.
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In Power BI Service, you may now quickly create an automatically generated report off the majority of datasets in the Power BI Service.  This makes 
it easy for you to explore all the datasets you have access to and can be helpful for jumpstarting report creation in the Power BI Service.

On the Create page, if you select the ‘Pick a published dataset’ option, you’ll be able to pick if you want to auto-create a report or, through the split 
button, if you want to start from a blank report.

You can also access these options in the Datahub, through the Create a report dropdown, where you can access both the auto-create and from-
scratch options.

There are still a few types of datasets Power BI doesn’t  yet support for auto-generated reports.  In these cases, you’ll just have the ‘blank report’ 
option available to you.

Auto-generate reports on existing datasets
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The latest updates also introduce another new feature which will make 
Business to Business (B2B) sharing easy for the consumers.  Power BI 
users who are guest users in any other tenant, will now see a new tab 
on their home page (in home tenant) called ‘From external orgs’.  This 
interface will list all artifacts that you have access to as a guest user 

(shared with you from external tenants).  The interface will allow you 
filter and sort through to find the content easily.  You may also see which 
organisation is sharing a specific document with you.  When you click on 
an artifact on this screen, a new window will open and take you to the 
relevant provider tenant for that artifact access.

Up until now, a Power BI report created with a font that was not available 
in the mobile device would display in the Power BI mobile app using the 
mobile device’s default font, rather than the font used by the report 
creator.

As of this update, the Power BI mobile applications now support the full 
range of fonts available in Power BI Desktop.  This means that in the 
mobile app, the report will look exactly as you designed it, with the same 
fonts that you chose when you created the report in Desktop.

The Power BI application for Windows is now aligned with the overall 
Power BI migration to Microsoft Edge WebView2, for faster performance 
and a better browsing experience all around.  To support WebView2, the 

minimum operating system (OS) required by the Power BI Windows app 
has changed to Windows 10 version 17763.  App upgrades will not be 
available for Windows devices running on earlier versions.

If you see one of these messages, you will need to install WebView2.

Discoverability feature for B2B content

Power BI fonts now available on mobile devices (iOS and Android)

Windows app: upgraded browsing experience with WebView2
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There is now a new library is available for embedding Power BI content 
in Vue.js applications.  This new library makes it easy to embed Power 
BI content and leverage Power BI embedded capabilities such as 
bootstrapping and phased embedding for better performance, applying 

styles to the embedded component, setting event handlers, and more.

The library is publicly available on npm and GitHub and also includes a 
demo application which you can run in just a few easy steps.

The release of this feature has been delayed until later this month.

Shortly, there will be some improvements to the Power BI integration 
in Jupyter notebooks, making it easier to embed Power BI reports in 
Jupyter notebooks.

The Powerbi-jupyter library is a Python IPyWidget that brings Power 
BI embedded capabilities to Jupyter notebooks, allowing users to tell 

complete stories with their data in their Jupyter notebooks.  The library 
supports embedding existing reports for both viewing and editing, and 
creating new reports based on data available in Power BI.

The update includes changes to the available authentication methods 
and the report embedding process, minimising the complexity, and 
making the embedding process simple and quick.

It is now possible to export paginated reports with Power BI datasets as a data source when the caller is a service principal, given that all downstream 
data sources are SSO-disabled.

The following are new visuals this update:

	 •	 Calendar by Datanau
	 •	 SuperTables by Apps for Power BI
	 •	 Selection Slicer by Walnut Innovation.

All HTML rendered through this Shielded HTML Viewer is sanitised to keep your data safe.  This first HTML Viewer Certified by Microsoft now is part 
of the first visuals you can buy and manage directly through Microsoft.

Microsoft announced this new functionality in July 2022.  It is currently in Preview and requires Power BI Desktop July 2022 or later.  Advantages 
include:
	 •	 obtain fine grained control of the assignment of licences
	 •	 (re)assign each licence to a user or group of users whenever you require
	 •	 purchase a licence for a single month or a whole year
	 •	make use of the optional auto-renewal feature
	 •	no longer need to enter (or update) a licence key: you manage your visual licences like you manage any other Microsoft licence.

Try the Shielded HTML Viewer now on your own data by downloading it from the AppSource.  All features are available for free to evaluate the 
Shielded HTML Viewer within Power BI Desktop.

Power BI component for Vue.js

Power BI and Jupyter integration updates (delayed until October 2022)

Export paginated reports by a service principal with a Power BI dataset as a data source

New visuals in AppSource

Shielded HTML Viewer by Nova Silva
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Drill Down Combo PRO offers plenty of customisation options, enabling 
you to visualise data in new ways.  This visual also features cross-chart 

filtering along with intuitive on-chart interactions, making the data 
exploration simpler for even the most inexperienced Power BI user.

The main features include:

	 •	multiple chart types: create column, line, and area charts
	 •	 full customisation: modify x and y axes, the legend, outline and fill settings
	 •	 choose normal, 100% proportional or zero-based stacking
	 •	 set up to four [4] static and dynamic thresholds to demonstrate targets
	 •	 conditional formatting for advanced customisation
	 •	 customise multiple series simultaneously with series and value label defaults
	 •	 touch-input device friendly.

In particular, there are popular use cases to mention too:

	 •	Sales and Marketing: sales strategies, results and campaign-by-campaign marketing metrics
	 •	Human Resources: hiring, overtime and efficiency ratios by department
	 •	Accounting and Finance: financial performance by region, office or business line
	 •	Manufacturing: production and quality metrics.

ZoomCharts Drill Down Visuals are known for interactive drilldowns, smooth animations and various customisation options.  They support interactions, 
selections, custom and native ToolTips, filtering, bookmarks and context menu.

This may be downloaded from AppSource.

Drill Down Combo PRO by ZoomCharts
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Arria’s custom visual for natural language generation has been improved.  
In the 3.4.0.0 release of Arria for Power BI, you’ll find a redesigned UI, 
significantly increased control over the building of narratives, and 
formatting improvements for better readability. 

Intelligent Narratives by Arria bring NLG to your dashboard, featuring 
a wide array of analysis types for generating plain-language reporting 
to complement your visuals.  Arria’s out-of-the-box narratives are user-
configurable and require no coding.

You may drill down into all your dashboard’s underlying data to tap into 
insights that you might otherwise miss.  From key driver analysis to anomaly 
detection, trend analysis to correlations, you no longer have to sift through 
voluminous data to get the answers to your organisation’s queries.

Choose the analysis type you need, then configure the narrative 
according to your business requirements.  Narratives are generated 
instantly, based upon your selections.

In addition to advanced Natural Language Generation (NLG), Arria’s custom visual also provides Natural Language Queries (NLQs).  

Again, this may be downloaded from AppSource.

Intelligent Narratives by Arria NLG
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Recently, Microsoft introduced ‘data preview’ as a new action on the 
dataset details page.  ‘Data preview’ enables you to view selected tables 
and columns from the dataset and provides entry points for exporting 
the data to supported file formats, customising it as a formatted table, 
and saving it as a paginated report.

‘Show query’ is a new capability added to ‘data preview’.  It allows you 
to copy to the clipboard the DAX query used to create the table preview.  
This may be useful for those who want to reuse the DAX query for future 
actions.

Column resizing, an additional capability, has been added to the data preview table.  With a rendered table, a user will be able to resize the width of 
the columns through a drag handle.  This functionality makes the table preview more readable, especially for long column input values.

To demonstrate, compare the old size

with the new size:

That’s it for this month.  See you in November!

Paginated reports data Preview

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

It’s been a busy month for Excel with recent new additions to Insider rolling out to the Current Channel, and the new IMAGE function too.  But that’s 
not even half of it.  The full list of updates for this month is as follows:

Yes, there might be a little repetition here.  Yes, there might be a little repetition here.  Yes, there might be a little repetition here.  Yes, there might 
be a little repetition here.  Yes, there might be a little repetition here…

Let’s plough through.

New Features for Excel

Excel for the web

	 •	New Excel functions
	 •	 Power Query Group operations
	 •	 Improvements to the connected Power BI experience
	 •	Add and edit rich text formatting
	 •	 Sort by colour or icon from AutoFilter menu
	 •	 Edit files with legacy data connections
	 •	 Edit files with legacy Shared Workbook feature
	 •	Delete chart elements
	 •	Multiline Formula bar	

Excel for Windows

	 •	New Excel functions
	 •	 IMAGE function (Insiders Beta)
	 •	 Improvements to the connected Power BI experience (Insiders 		
	 	 Beta)
	 •	 Show Changes (Insiders CC Preview)

Android

	 •	New Excel functions
	 •	 IMAGE function (Insiders Beta)

iOS

	 •	New Excel functions
	 •	 IMAGE function (Insiders Beta).

Since Wednesday 17 August, 14 new Excel functions have been rolling 
out to all subscription users in the Current Channel for all endpoints.  
The full list of these functions (and what they do) is repeated here for 
information.

Around for a while now, the updated text functions were originally 
available to Beta channel users starting with build 15316.20000.  Some 
changed, but all remain useful…

The TEXTBEFORE function returns the string of text that occurs before a 
given substring (i.e. a character or set of characters) in that string.  It is 
the opposite of the TEXTAFTER function.  TEXTBEFORE has the following 
syntax:

TEXTBEFORE(text, delimiter, [instance number], [match mode], [match 
end], [if not found])

The TEXTBEFORE function has the following arguments:

	 •	 text: this is required and represents the text string you are 		
		  searching within.  Wildcard characters are not allowed
	 •	 delimiter: this is also required and represents the text in the text 	
		  string that marks the point before which you wish to extract
	 •	 instance number: this is the first optional argument and denotes  
		  the nth instance of the delimiter before which you wish to 		
		  extract.  By default, this is equal to one [1].  If a negative number 	
		  is used here, the function starts searching for the delimiter from 	
		  the end rather than the beginning

	 •	 match mode: this is the second optional argument, and  
		  determines whether the text search is case-sensitive.  The default  
		  is case-sensitive.  If used, you should enter one of the following  
		  two [2] values:
			   o	 0: case sensitive
			   o	 1: case insensitive
	 •	 match end: also optional, this treats the end of the text as a  
		  delimiter.  By default this is viewed as an exact match.  If used, 	
		  you should enter one of the following two [2] values:
			   o	 0: do not match the delimiter against the end of the text
			   o	 1: match the delimiter against the end of the text

	 •	 if not found: this too is an optional argument and provides the 		
		  value should no match be found.  If not used and no match is found,  
		  #N/A will be returned.

New Excel functions

The TEXTBEFORE function
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It should be further noted that: 

	 •	when searching with an empty delimiter value, TEXTBEFORE matches immediately.  It returns empty text when searching from the front  
		  (if instance number is positive) and the entire text when searching from the end (if instance number is negative)
	 •	 Excel returns an #VALUE! error if the instance number is zero (the default is one) or if the instance number is greater than the length of the text
	 •	 Excel returns an #N/A error if the delimiter does not occur within the text
	 •	 Excel returns an #N/A error if the instance number is greater than the number of occurrences of the delimiter within the text.

Please see the examples below: 

The TEXTAFTER function returns the string of text that occurs after a given substring (i.e. a character or set of characters) in that string.  It is the 
opposite of the TEXTBEFORE function.  TEXTAFTER has the following syntax:

TEXTAFTER(text, delimiter, [instance number], [match mode], [match end], [if not found])

The TEXTAFTER function
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The TEXTAFTER function has the following arguments:
	 •	text: this is required and represents the text string you are 

searching within.  Wildcard characters are not allowed
	 •	delimiter: this is also required and represents the text in the text 

string that marks the point after which you wish to extract
	 •	instance number: this is the first optional argument and denotes 

the nth instance of the delimiter after which you wish to extract.  
By default, this is equal to one [1].  If a negative number is used 
here, the function starts searching for the delimiter from the end 
rather than the beginning

	 •	match mode: this is the second optional argument, and 
determines whether the text search is case-sensitive.  The default 
is case-sensitive.  If used, you should enter one of the following 
two [2] values:

			   o	 0: case sensitive
			   o	 1: case insensitive
	 •	match end: also optional, this treats the end of the text as a 

delimiter.  By default this is viewed as an exact match.  If used, you 
should enter one of the following two [2] values:

			   o	 0: do not match the delimiter against the end of the text
			   o	 1: match the delimiter against the end of the text
	 •	if not found: this too is an optional argument and provides the 

value should no match be found.  If not used and no match is 
found, #N/A will be returned.

It should be further noted that: 
	 •	when searching with an empty delimiter value, TEXTAFTER 

matches immediately.  It returns the entire text when searching 
from the front (if instance number is positive) and empty text 
when searching from the end (if instance number is negative)

	 •	Excel returns an #VALUE! error if the instance number is zero (the 
default is one) or if the instance number is greater than the length 
of the text

	 •	Excel returns an #N/A error if the delimiter does not occur within 
the text

	 •	Excel returns an #N/A error if the instance number is greater than 
the number of occurrences of the delimiter within the text.

Please see relevant examples below: 

The TEXTSPLIT function
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The TEXTSPLIT function is intended to work like the Text to Columns button on the Data tab of the Ribbon, almost like the “inverse” of the TEXTJOIN 
function.  It allows you to split a given text across rows or down columns.  TEXTSPLIT has the following syntax:

TEXTSPLIT(text, [column delimiter], [row delimiter], [ignore empty], [match mode], [pad with])

The TEXTSPLIT function has the following arguments:

	 •	 text: this is required and represents the text string you wish to 		
		  split
	 •	 column delimiter: this is optional and denotes one or more  
		  characters that specify where to spill the text across columns
	 •	 row delimiter: this is optional and denotes one or more characters  
		  that specify where to spill the text down rows
	 •	 ignore empty: another optional argument, you should specify  
		  TRUE to create an empty cell when two delimiters are used.  This  
		  argument defaults to FALSE, which means don't create an empty 	
		  cell
	 •	match mode: this is the second optional argument, and  
		  determines whether the text search is case-sensitive.  The default 	

		  is case-sensitive.  If used, you should enter one of the following  
		  two [2] values:
			   o	 0: case sensitive
			   o	 1: case insensitive
	 •	pad with: not to be confused with Pad Thai, this final optional 		
		  argument “pads” the resulting text range where cells would  
		  otherwise be blank. The default is N/A.

Please note that you will need to update any TEXTSPLIT functions 
previously written if you used the pad with argument, as this argument 
has moved from the fifth to the sixth argument.  

If there is more than one delimiter (row or column), then an array 
constant must be used.  For example, to split by both a comma (,) and a 
period (full stop, .), use =TEXTSPLIT(text, {",", "."}).

Just for a change, some more examples: 

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

You can now perform various operations on Power Query groups in 
Excel for the web to better organise your queries and easily consume 
the data on the queries pane.  This has now been extended to all Office 

365 subscribers with Business or Enterprise plans.  We detailed this last 
month, but below is a reminder.

	 •	 Select the top-level button and then choose ‘New group’

To begin, open the Queries pane, select the Data tab and then choose Queries.

Power Query Group operations

Create a new group
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	 •	Give the new group a name; you can also enter a description should you wish

	 •	When you are done, choose Save

	 •	 You will see the new group was created:

You should note that until you move queries into groups, all queries will be listed under the ‘Other queries’ group.

	 •	 Select the top-level button and then choose ‘Expand all’ / ‘Collapse all’ as required

	 •	 If the group contains queries, you can refresh all of them at once, the same way you can refresh individual queries
	 •	 To do this, select the action menu button and then choose Refresh.

Obviously, refresh will work for supported data sources only.

	 •	 You will see the result of the respective action in the Queries pane.

Again, you should note that you can Expand or Collapse any group by using the arrow next to the group name.

Expand / collapse all groups

Refresh a group
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	 •	 If you want to reorganise your queries and take them out of the group, you can use this operation
	 •	 To do this, select the action menu button and then choose Ungroup

	 •	 To do this, select the action menu button and then choose Rename

	 •	 To do this, select the action menu button and then choose ‘Delete group’.

	 •	 To do this, select the action menu button and then choose ‘Move to group…’

At this stage, delete is supported for empty groups only.  Microsoft has stated it is working on adding support for deleting groups that include queries.

	 •	 Enter the new name, then press anywhere to save changes.

You should note that this action will only delete the group, not the queries in this group.

Ungroup the queries within a group

To rename a group

To delete a group

Move a query or group into another group
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	 •	 Select the item you want to move it to and then select Save.

	 •	 If a group is nested within one or more groups, you can quickly move it to the top level
	 •	 To do this, select the action menu button and then choose ‘Move to top level’.

	 •	 To do this, select the action menu button and then choose Properties

	 •	 You can use this to rename the group or change its description
	 •	When you are done, select Save

Move a group to the top level

Edit a group’s properties
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	 •	 You will be able to see the group description by hovering over it.

Apparently, Microsoft’s future plans include Query operations, amongst other ideas.  The end goal is to release the full Power Query Editor experience 
to Excel for the Web eventually.

In both Excel for the web and Excel for Windows, you can now create a 
PivotTable that connects directly to a Power BI dataset.  This allows you 
to analyse data between platforms seamlessly.  With this set of updates, 
Microsoft has improved the experience of analysing data in PivotTables.

One upgrade that has been made is to enable proper date support for 
Power BI-connected PivotTables.  Previously, dates were recognised 
as text strings.  Now, they are date-and-time objects, which allows for 
accurate time-based filtering and sorting of data.

For date support:

	 •	 create a PivotTable connected to a Power BI dataset

	 •	 if the dataset has a date field that you’d like to use in your analysis,  
		  drag the field into an area of the PivotTable fields list (e.g. rows,  
		  columns, filters)

Improvements to the connected Power BI experience
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	 •	 Filter or sort the field in your PivotTable as desired.

That’s not all.  Support for implicit measures has now been enabled in Power BI–connected PivotTables.  These now support  drag-and-drop 
aggregations (e.g. sum, average, distinct count) of fields without previously needed pre-defined measures (i.e. explicit measures) in the underlying 
Power BI datasets.  

For drag and drop aggregation support:

	 •	 create a PivotTable connected to a Power BI dataset
	 •	 drag any field into the ‘Values’ area of the PivotTable fields list

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

	 •	 create aggregations on the field as desired.

The above will be rolled out to all users of Excel for the web and to Insiders running Beta Channel Version 2208 (Build 15601.20028) or later for 
Windows in due course.

This one I use all the time!  Also for Excel for the web, rich text formatting allows you to add formatting to only part of the text within a cell.  You can 
use the Ribbon or shortcuts to add the formatting, e.g.

Sorting is now easier and more convenient with new sort-by-colour or icon options in Excel for the web:

Add and edit rich text formatting

Sort by colour or icon from AutoFilter menu
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You can now edit files that contain legacy data connections like Text 
Queries, Web Queries, Query Table or SharePoint Lists in Excel for the 
web.  This enables interaction with the workbook and access to the 
previously stored data from these connections, but without interaction, 

modification or refreshing of the connections themselves.  Microsoft 
recommends switching to import data via Power Query to connect and 
refresh data.  

You can now edit files that use the legacy shared workbook feature in Excel for the web, with a provision for one-click turn-off of the legacy feature, 
thus allowing you to interact and collaborate with the workbook.

Deleting a data series from charts in Excel for the web is now easier by selecting a series and pressing the delete / backspace key to remove it.

And there is more for Excel for the web!  Users may now expand and collapse the Formula bar by using the chevron or manually resizing it.  This 
capability Improves the readability of long formulae or text, viz.

Edit files with legacy data connections

Edit files with legacy Shared Workbook feature

Delete chart elements

Multiline Formula bar
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Your images can now be part of a worksheet in pretty much any version 
of Excel (either for the web, or some Insiders Beta variant), instead of 
floating on top of the cells.  You may move and resize cells, sort and filter, 
and work with images within an Excel table.  This improvement unlocks 
and facilitates many new scenarios, such as tracking inventories, creating 

employee dashboards or building games and brackets – something I 
know you are all especially keen to do!

The IMAGE function inserts images into cells from a source location, 
along with alternative text.  Its syntax is as follows:

These include:

	 •	 if the URL to the image file you are using is pointing to a site that requires authentication, the image will not render
	 •	 zooming in and out with images in cells may distort the images
	 •	moving between platforms (for example, Windows and Mac) may result in irregular image rendering. 

You may insert a sphere into a cell by typing 

=IMAGE(“https://support.content.office.net/en-us/media/2d9e717a-0077-438f-8e5e-f85a1305d4ad.jpg”, “Sphere”)

Alternatively, you may insert a cylinder into a cell as follows:

	 •	 Copy and pasting the following URL into cell B1: 
		  https://support.content.office.net/en-us/media/35aecc53-b3c1-4895-8a7d-554716941806.jpg 
	 •	 Type “Cylinder” in cell B2
	 •	 Enter the formula =IMAGE(B1,B2,0) in cell A3 and pressing the ENTER key.

The arguments are as follows:

•	 source is required, and represents the URL path of the image 		
	 file, using an https protocol (it should be noted that supported 		
	 file formats include BMP, JPG, JPEG, GIF, TIFF, PNG, ICO and 		
	 WEBP).  Upon tinkering, cell references within the workbook 		
	 appear to be recognised too
•	 alt_text is the first optional argument.  This is the alternative text 	
	 that describes the image (for accessibility purposes)
•	 sizing is also an optional parameter and specifies the image 		
	 dimensions.  There are several possible values:

			 

		  o	 0: fit the image in the cell and maintain its aspect ratio 		
				    (default)
		  o	 1:	fill the cell with the image and ignore its aspect ratio
		  o	 2: maintain the original image size, which may exceed the 	
				    cell boundary
		  o	 3:	customise the image size by using the height and width 	
				    arguments (see below)
•	 height and width are optional arguments.  These define the height 	
	 and width respectively of the image only when using sizing option  
	 3 (see above).

IMAGE(source, [alt_text], [sizing], [height], [width])

IMAGE function (Insiders Beta)

Known issues

Examples
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The IMAGE function is available to Insiders running the following Beta Channel builds:

	 •	Windows: Version 2209 (Build 15608.10000) or later
	 •	Mac: Version 16.65 (Build 22080701) or later
	 •	 iOS: Version 2.65 (Build 22080701) or later
	 •	Android: 16.0.15608.10000 or later.

Show Changes in Excel lets you see exactly what edits were made to your 
workbooks, so you can confidently allow others to collaborate on your 
work.  This is for all versions of Excel, subject to Preview.  You can see 

details of who changed what, where and when, along with the previous 
value of the cell for quick reversion.  

Microsoft has released an ‘Excel Features Availability’ flyer to detail all of these items:

You can narrow down the list of changes by selecting any sheet, range, 
or individual cell, to see all changes that were made, including bulk edits.  
You can see past changes for up to 60 days.  

To view changes for the entire workbook:

	 •	 in the Review tab on the Ribbon, select ‘Show Changes’
	 •	 changes are shown in the pane with the most recent changes on 	
		  top, in the order the changes were made
	 •	 you can see who made edits, exactly where in the workbook, 		
		  when, and what they changed
	 •	 you can also see ‘Changes made at once’ by clicking on ‘See  
		  changes’ in a bulk card.

You should note that ‘Show Changes’ tracks changes made from 
Windows Desktop, Excel on the Mac, iPad, iOS and Android phones.  You 
can see past changes for up to 60 days. 

To filter and see changes for a subset or range 

	 •	 select any sheet, range or single cell
	 •	 right-click to open the context menu and select ‘Show Changes’.  

If you or others edit the workbook while this pane is open, select the ‘See 
New Changes’ button to update the changes.  The notification lets you 
stay in control when you want to refresh the list and not be distracted 
when reviewing changes. 

To filter changes from the Changes pane:

	 •	 at the top of the pane, select the Filter icon  
	 •	 select Range or Sheet to filter the changes shown, and then do the 	
		  following:

			   o	 to show a range or cell’s changes, select Range and enter the 	
				    range or cell in the text box
			   o	 select the arrow icon next to the text box to confirm.

Show Changes (Insiders CC Preview)
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You can find the updated version of this grid with the interactive links at aka.ms/ExcelFeaturesFlyer. 

INDEX with its best friend MATCH – as a combination – are two of the 
most useful functions at a modeller’s disposal.  They provide a versatile 
lookup in a way that LOOKUP, HLOOKUP and VLOOKUP simply cannot.  
The best way to illustrate this point is by means of an example.  

Here is a common problem.  Imagine you have built a financial model 
and your Balance Sheet – ahem! – contains misbalances.  You need to fix 
it.  Now I am sure you have never had this mistake yourself, but you have 

“close friends” that have encountered this feast of fun: solving Balance 
Sheet errors can take a long while.  One of the first things modellers will 
do is locate the first period (in ascending order) that has such an error, 
as identifying the issue in this period may often solve the problem for all 
periods. 

Consider the following example:

This is a common modelling query.  The usual suspects, LOOKUP and 
HLOOKUP / VLOOKUP do not work here:

	 •	 LOOKUP(lookup_value, lookup_vector, [result_vector]) gives the 	
		  wrong date as the balance checks are not in strict ascending order 	
		  (i.e. ascending alphanumerically with no duplicates); whilst

	 •	HLOOKUP(lookup_value, table_array, row_index_number, [range_	
		  lookup]) gives #VALUE! since the first row must contain the data 	

		  to be ‘looked up’, but the Balance Check is in row 13 in our 		
		  example above, whereas the dates we need to 			 
		  return are in row 4 – hence we get a syntax error.

There is a solution, however: INDEX MATCH.  They form a highly versatile 
tag team, but are worth introducing individually.

The A to Z of Excel Functions: INDEX 

Essentially, INDEX(array, row_number, [column_number]) returns a 
value or the reference to a value from within a table or range (list).  For 
example, INDEX({7,8,9,10,11,12},3) returns the third item in the list 

{7,8,9,10,11,12}, i.e. 9.  This could have been a range: INDEX(A1:A10,5) 
gives the value in cell A5, etc.

INDEX
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INDEX can work in two dimensions as well (hence the column_number reference).  Consider the following example:

INDEX(F11:L21,4,5) returns the value in the fourth row, fifth column of the table array F11:L21 (clearly 26 in the above illustration).  

MATCH is fairly straightforward to use:

MATCH(lookup_value, lookup_vector, [match_type]) returns the 
relative position of an item in an array that (approximately) matches a 
specified value.  It is not case sensitive.

The third argument, match_type, does not have to be entered, but for 
many situations, I strongly recommend that it is specified.  It allows one 
of three values:

	 •	match_type 1 [default if omitted]: finds the largest value less than 	
		  or equal to the lookup_value – but the lookup_vector must be in 	
		  strict ascending order, limiting flexibility

	 •	match_type 0: probably the most useful setting, MATCH will find 	
		  the position of the first value that matches lookup_value exactly.  	
		  The lookup_array can have data in any order and even allows 		
		  duplicates

	 •	match_type -1: finds the smallest value greater than or equal to 	
		  the lookup_value – but the lookup_array must be in strict 		
		  descending order, again limiting flexibility.

When using MATCH, if there is no (approximate) match, #N/A is returned 
(this may also occur if data is not correctly sorted depending upon 
match_type).

Whilst useful functions in their own right, combined they form a highly versatile partnership.  Consider the original problem:

In the figure above, MATCH(“d”,F12:F22,0) gives a value of 6, being the 
relative position of the first ‘d’ in the range.  Note that having match_
type 0 here is important.  The data contains duplicates and is not sorted 

alphanumerically.  Consequently, using match_type 1 and -1 would give 
the wrong answer: 7 and #N/A respectively.

MATCH

INDEX MATCH
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MATCH(1,J13:O13,0) equals 5, i.e. the first period the balance sheet 
does not balance in is Period 5.  But we can do better than that.  
INDEX(J4:O4,5) equals May-20, so combining the two functions:

INDEX(J4:O4,MATCH(1,J13:O13,0))

equals May-20 in one step.  This process of stepping out two calculations 
and then inserting one into another is often referred to as “staggered 
development”.  No, this is not how you construct a financial model late 
in the evening after having the odd drink or two!

Do note how flexible this combination really is.  We do not need to specify 
an order for the lookup range, we can have duplicates and the value to 
be returned does not have to be in a row / column below / to the right 
of the lookup range (indeed, it can be in another workbook never mind 
another worksheet!).  With a little practice, the above technique can be 
extended to match items on a case sensitive basis, use multiple criteria 
and even ‘grade’.  

The INDIRECT(ref_text,[a1]) function syntax has two arguments:

	 •	 ref_text: this is a required reference to a cell that contains an A1- 
		  style reference, an R1C1-style reference, a name defined as a  
		  reference or a reference to a cell as a text string.  If ref_text is  
		  not a valid cell reference, INDIRECT returns the #REF! error value.   
		  If ref_text refers to another workbook (an external reference),  
		  the other workbook must be open.  If the source workbook is not  
		  open, INDIRECT again returns the #REF! error value. 

	 •	 [a1] This is optional (hence the square brackets) and represents  
		  a logical value that specifies what type of reference is contained  
		  in the cell ref_text.  If a1 is TRUE or omitted, ref_text is interpreted  
		  as an A1-style reference.  If a1 is FALSE, ref_text is interpreted  
		  as an R1C1-style reference.  Most modellers seldom consider this  
		  alternative referencing approach, which is not without its merits  
		  (see below).

Essentially, INDIRECT works as follows:

In the above example, the formula in cell H18 (the yellow cell) is

=INDIRECT(H11).

With only one argument in this function, INDIRECT assumes the A1-cell notation (e.g. the cell in the third row fourth column is cell D3).  Note that 
the value in cell H11 is H13, this formula returns the value / contents of cell H13, i.e. 187.  

This idea can be extended: the value indirectly referred to does not need to be in the same worksheet (or even workbook) as follows:

The A to Z of Excel Functions: INDIRECT

Excel’s INDIRECT function allows the creation of a formula by referring to the contents of a cell, rather than the cell reference itself.  

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

The formula in the yellow-coloured cell (H17) uses concatenation:

=INDIRECT("'"&H11&"'!"&H12).

This formula is difficult to read.  Let’s make it clearer.  H11 in my example is Sum_First_Ten_Rows_BA, which is the name of another worksheet in 
the workbook and F29 is the cell to be linked to.  In other words, this formula becomes

=’Sum_First_Ten_Rows_BA’!F29,

which will make more sense to end users.  The point is, however, the value in cell H11 can be changed so that the formula suddenly links to a 
completely different worksheet.

Eagle-eyed readers may note that worksheet names without spaces do not need apostrophes.  Whilst this is true, I include them here so that the 
formula will work in general.

Imagine you wanted to sum the first ten values in this list.  The obvious 
formula to use would be

=SUM(F11:F20).

However, what happens if someone inadvertently inserts or removes 
rows in this range?  If a row were to be inserted the formula would 
automatically update to =SUM(F11:F21), which most of the time would 
be what would be required.  On occasion, though, it might be important 
that only the first ten values are still summed.  INDIRECT can ensure this 
happen, viz.

=SUM(INDIRECT("F11:F20")).

Note that when a reference is typed in like this it should be included 
in inverted commas as displayed.  Using this formula will maintain the 
integrity of the referencing as required.

So far, all of my examples use the A1-style of cell referencing.  However, 
using the R1C1 (row / column approach where the third row fourth 
column would be (3,4)) has benefits too.  When this method is used, I 
often use INDIRECT in conjunction with the ADDRESS function.

The ADDRESS(row_number, column_number) function syntax has the 
following arguments:

	 •	 row_number is a numeric value that specifies the row number to 	
		  use in the cell reference

	 •	 column_number is also required and is a numeric value that 		
		  specifies the column number to use in the cell reference.

INDIRECT has useful properties that may be exploited.  For example, consider the following illustration:

Advantages of INDIRECT
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Therefore =ADDRESS(3,4) is $D$3.

Just using INDIRECT in the example above, cell H29 uses concatenation 
once more:

=INDIRECT("R"&H11&"C"&H12,FALSE).

The second argument (FALSE) is necessary to recognise the R1C1 
notation.  Here, this formula reduces to =R22C9, which is the 22nd row, 
ninth column, i.e. delivers the value in cell I22 (highlighted in red).

This formula can be difficult to understand for the uninitiated.  Now, 

we’re not saying the following is necessarily simpler, merely it is an 
alternative.  The second formula in cell H31 is

=INDIRECT(ADDRESS(H11,H12)).

This does not need the R1C1 notation as ADDRESS(H11,H12) equals cell 
$I$22.

Another advantage is in generating dynamic data validation lists.  

Here, we want to select a classification category in cell G28, based upon 
the financial statement selected in cell G27 (e.g. Balance Sheet, Current 
Assets).

The trick here is not to include spaces in the names of the financial 
statements.

Then, first of all, in my illustration above, we’ve have named cells F12:F22 
Income_Statement, cells G12:G19 Balance Sheet and cells H12:H15 
Cash_Flow_Statement.  Cells F11:H11 have been used to construct a 
data validation list in cell G27 and then the data validation list in cell G28 
has used the INDIRECT function in the ‘Source:’ field as follows:
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As a different financial statement is selected in cell G27, so the list will 
update in cell G28 (but only once the data validation list is activated, 
which is an Excel limitation).

One last – and key – example: how often do you seek a summary sheet 
which selects data from one of several similarly constructed datasheets?  

We have seen all sorts of weird and wonderful formulae to perform 
this common requirement, but INDIRECT is by far one of the simplest 
approaches available.

Consider the following file, which has several similar worksheets:

We might require a summary sheet:
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In this example, we have called our similar worksheets Guns_BA and 
Drugs_BA.  The BA here refers to “Blank Assumptions” but it could mean 
“Basically Anything”, i.e. the worksheet names contain more than just 
the business unit name.

With cell H9 named Selection, the formula used in the calculations is 
simply

=INDIRECT("'"&Selection&"_BA'!RC",FALSE).

(the necessary apostrophes are coloured in red in this above formula).  

However, as well as apostrophes and concatenation this formula uses a 
neat trick.  The second argument must be FALSE (i.e. the formula assumes 
the R1C1 notation).  When this is selected the RC in the above formula 
means use the row and column reference of the cell this formula is in.  
This avoids unnecessary hard code and generates a formula that changes 
reference depending upon the formula location in the worksheet.  For 
example, in cell G12, the formula reduces to =’Guns_BA’!G12 and in cell 
J21, it reduces to =’Guns_BA’!J21, etc.

Very useful!

Not all modellers embrace this useful function.  There are three key 
issues with INDIRECT:

	 1.	 INDIRECT encourages the use of hard code in formulae.  This 		
		  should always be a last resort as this leads to a potential lack of 	
		  transparency and flexibility in a model

	 2.	 INDIRECT is a difficult function to review / audit, as the cell(s) it  
		  refers to is not the ultimate location of the value used in the  
		  formula.  Excel’s in-built auditing tools are of limited use and the  
		  formulae can be highly confusing and ‘clunky’

	 3.	 If ref_text refers to a cell range outside the row limit of 1,048,576  

		  or the column limit of 16,384 (XFD), INDIRECT returns an #REF!  
		  error.  However, this behaviour is different in earlier versions 		
		  of Excel, which ignored the exceeded limit and returned an  
		  often meaningless value instead.  This can lead to compatibility 	
		  issues between versions of Excel (admittedly, these earlier 		
		  versions are outdated, no longer supported, and therefore, 		
		  should not be used).

Ultimately, the use of INDIRECT becomes a subject “horses for courses” 
issue.  If modellers are knowledgeable and wary of its limitations, 
INDIRECT can simplify and resolve many common modelling problems.  
Just be careful out there.

The INFO function returns information about the current operating environment.  It employs the following syntax to operate:

INFO(type_text).

The INFO function has the following argument:

	 •	 type_text: this is required and represents the specification of what type of information you want returned. 

Disadvantages of INDIRECT

The A to Z of Excel Functions: INFO

type_text Returns

“directory” Path of the current directory or folder

“numfile” Number of active worksheets in the open workbooks

“origin” Returns the absolute cell reference of the top and leftmost cell visible in 
the window, based on the current scrolling position, as text prepended 
with "$A:". This value is intended for Lotus 1-2-3 release 3.x compatibility.  
The actual value returned depends on the current reference style setting.  
Using D9 as an example, the return value would be: 

	 •	 A1 reference style     "$D$9"
	 •	 R1C1 reference style    "R9C4"

“osversion” Current operating system version, as text
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type_text Returns

“recalc” Current recalculation mode; returns "Automatic" or "Manual"

“release” Version of Microsoft Excel, as text

“system” Name of the operating environment:
	 •	 Macintosh = "mac"
	 •	 Windows = "pcdos"

It should be noted that:

	 •	 in previous versions of Microsoft Excel, the "memavail", "memused" and "totmem" type_text values returned memory information.  These 	
		  type_text values are no longer supported and now return an #N/A error value instead.

Please see our example below: 

More Excel Functions next month.

Beat the Boredom Suggested Solution

If you are one of those people that reads the newsletter from back to front, then this might be the challenge for you!  We shall reverse judgment.

So this month’s challenge was as follows:

For all current versions of Excel (not just Office 365, Excel on the web and Insider / Beta variants), write a formula that will reverse the text in a cell 
(i.e. reverse the text string).  You cannot use VBA, dynamic arrays, JavaScript, TypeScript or Office Scripts.

It’s always dangerous to state that you can’t do something in Excel.  
No disrespect is intended upon the authors of the Microsoft Research 
article, but we have often found it to be the case that saying such a thing 
may demonstrate a lack of Excel vocabulary and / or imagination.  After 
all, necessity is often the mother of invention!  

Having stated you might need an extended function knowledge and 
innovation, let’s fall back on brute force and ignorance (I have the latter 
in abundance).  We are going to need several functions.  

The first one, LEN(text), gives the length of text in terms of the number of 
characters contained within the text string (including blank spaces), e.g.

=LEN("Mary Had a Little LAMBDA")

has a value of 24, being the total number of characters in the text string, 
including the total number of spaces between words.  You might not be 
sure where this is going at this point, but don’t worry: all will become 
clear shortly.  First though, let’s introduce the next function, INDIRECT, 
in a little more detail.

Excel’s INDIRECT function allows the creation of a formula by referring to 
the contents of the argument (cell), rather than the cell reference itself.  

INDIRECT(ref_text, [a1])

The function syntax has two arguments:

	 1.	ref_text: this is a required reference to a cell that contains an 	  
		  A1-style reference, an R1C1-style reference, a name defined as a  
		  reference or a reference to a cell as a text string.  If ref_text is  
		  not a valid cell reference, INDIRECT returns the #REF! error value.   

		  If ref_text refers to another workbook (an external reference), 	 
		  the other workbook must be open.  If the source workbook is not  
		  open, INDIRECT again returns the #REF! error value

	 2.	[a1]: this is optional (hence the square brackets) and represents  
		  a logical value that specifies what type of reference is contained  
		  in the cell ref_text.  If a1 is TRUE or omitted, ref_text is  
		  interpreted as an A1-style reference.  If a1 is FALSE, ref_text is  
		  interpreted as an R1C1-style reference.  

The Challenge

Suggested Solution

The INDIRECT Function
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Essentially, INDIRECT works as follows:

In the above example, the formula in cell D6 (the blue cell) is

=INDIRECT(D2).

With only one argument in this function, INDIRECT assumes the A1 cell 
notation (e.g. the cell in the third row fourth column is cell D3).  Note 

that the value in cell D2 is D4, so this formula returns the value / contents 
of cell D4, i.e. 77.  

This idea can be extended: the value indirectly referred to does not need 
to be in the same worksheet (or even workbook), or may even be of 
another type altogether.

Hang on a minute: this is spilling – we are using dynamic arrays, and these are not allowed for the purposes of the challenge.  Well, yes and no; you 
may use =INDIRECT(“1:3”) in all current versions of Excel, it’s just this formula cannot be rendered in all versions.  But that’s not what we want in 
any case. 

Let’s consider =INDIRECT(1).  This would return #REF! because the intermediary reference 1 is meaningless in Excel.  Yes, it constitutes a value, but 
INDIRECT is looking for a cell / range reference.  You might think =INDIRECT(1:3) would reference rows 1 to 3 in Excel, but you would be wrong:

This is incorrect syntax.  It needs to be =INDIRECT(“1:3”) because INDIRECT is expecting to convert text to a reference it can resolve, viz.

Returning to the Suggested Solution
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Now, let’s extend the idea.  Let’s consider =ROW(INDIRECT(“1:3”)):

This example has deliberately changed the occasional values in rows 1 to 3 to demonstrate that this has nothing to do whatsoever with the contents 
of rows 1 to 3.  It’s generating the numbers 1, 2 and 3 as ROW(1) equals 1, ROW(2) equals 2 and ROW(3) equals 3.  The ROW function has essentially 
passed the range argument “1:3” to whatever function or operation it has been set up for.

Just for completion and in case you are wondering, we cannot use COLUMN:

This would always extend to 16,384 columns (!). 

If we combine this result with LEN from earlier,

=ROW(INDIRECT("1:"&LEN("Mary Had a Little LAMBDA")))

I would get

(The & operator simply joins arguments together.)

It should be noted that this list of the numbers 1 to 24 might not display in all versions of Excel, but the calculation engine would recognise the list.  
We may even reverse the order:
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The formula

=LEN(A1)-ROW(INDIRECT("1:"&LEN(A1)))+1

takes the list generated earlier (ROW(INDIRECT("1:"&LEN(A1)))) and subtracts it from the length of the text string in cell A1 and adds one [1].   
The first number would be 24 – 1 + 1 = 24, the second would be 24 – 2 + 1 = 23, the third would be 24 – 3 + 1 = 22, and so on.

Now we’re ready to introduce my next function.

The MID function returns a specific number of characters from a text string, starting at the position you cite, based upon the number of characters 
you specify.

The MID function employs the following syntax to operate:

MID(text, start_number, number_of_characters)

The MID function has the following arguments:

	 •	 text: this is required and represents the text string that contains the characters you want to extract
	 •	 start_number: this is also required and specifies the position of the first character you want to extract from text.  The first character in text has  
		  start_number 1, and so on
	 •	number_of_characters: this argument is mandatory too and specifies the number of characters you want MID to return from the text.

It should be further noted that: 

	 •	 if start_number is greater than the length of text, MID returns "" (empty text)
	 •	 if start_number is less than the length of text, but start_number plus number_of_characters exceeds the length of text, MID returns the  
		  characters up to the end of text
	 •	 if start_number is less than 1, MID returns the #VALUE! error value
	 •	 if number_of_characters is negative, MID returns the #VALUE! error value.

As an example,

=MID(“Mary Had a Little LAMBDA”,12,6)

would return the text string “Little”, being the sub-text string starting at the 12th character, consisting of six [6] characters.

The MID Function

It starts to come together now.  Consider

=MID(A1,LEN(A1)-ROW(INDIRECT("1:"&LEN(A1)))+1,1)

in our above example:

Returning to the Suggested Solution
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In some versions of Excel, you may need to enter this formula using CTRL + SHIFT + ENTER, but even with older versions, this requirement should be 
unnecessary.

Until next time.

Each cell takes the nth character in the reverse list from the text string in cell A1.  We simply need to join it together.

=CONCAT(MID(A1,LEN(A1)-ROW(INDIRECT("1:"&LEN(A1)))+1,1))

The CONCAT function replaces the old CONCATENATE function and combines the text from multiple ranges and / or text strings:

CONCAT(text1, [text2],…)

where text1 is the text item to be joined and text2 (onwards) are the additional items to be joined.

This is why you don’t need to worry about spilling: we do not require our result to spill, and we are not using any dynamic array functions – as per 
the requirements.

Word to the Wise

 

Upcoming SumProduct Training Courses - COVID-19 update
Due to the COVID-19 pandemic that is currently spreading around 
the globe, we are suspending our in-person courses until further 
notice.  However, to accommodate the new working-from-home 
dynamic, we are switching our public and in-house courses to 
an online delivery stream, presented via Microsoft Teams, with 
a live presenter running through the same course material, 
downloadable workbooks to complete the hands-on exercises 
during the training session, and a recording of the sessions for 

your use within 1 month for you to refer back to in the event 
of technical difficulties.  To assist with the pacing and flow of 
the course, we will also have a moderator who will help answer 
questions during the course.

If you're still not sure how this will work, please contact us at 
training@sumproduct.com and we'll be happy to walk you 
through the process.
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Link to Others
These newsletters are not intended to be 
closely guarded secrets.  Please feel free 
to forward this newsletter to anyone you 
think might be interested in converting to 

“the SumProduct way”.

If you have received a forwarded 
newsletter and would like to receive 
future editions automatically, please 

subscribe by completing our newsletter 
registration process found at the foot of 
any www.sumproduct.com web page.

Any Questions?
If you have any tips, comments or queries 
for future newsletters, we’d be delighted 
to hear from you. Please drop us a line at 

newsletter@sumproduct.com.

Our Services
We have undertaken a vast array of 
assignments over the years, including:
· 	 Business planning
· 	 Building three-way integrated 		
	 financial statement projections
· 	 Independent expert reviews
· 	 Key driver analysis
· 	 Model reviews / audits for internal 	 	
	 and external purposes
· 	 M&A work
· 	 Model scoping
· 	 Power BI, Power Query & Power Pivot
· 	 Project finance
· 	 Real options analysis
· 	 Refinancing / restructuring
· 	 Strategic modelling
· 	 Valuations
· 	 Working capital management
If you require modelling assistance of any 
kind, please do not hesitate to contact us 
at contact@sumproduct.com.

Training
SumProduct offers a wide range of 
training courses, aimed at finance 
professionals and budding Excel experts. 
Courses include Excel Tricks & Tips, 
Financial Modelling 101, Introduction to 
Forecasting and M&A Modelling. 

Drop us a line at training@sumproduct.com 
for a copy of the brochure or download  
it directly from 
www.sumproduct.com/training.

Check out our 
more popular 
courses in 
our training 
brochure:

Key Strokes
Each newsletter, we’d like to introduce you to useful keystrokes you may or may not be aware of.  This month, we look again at the CTRL 
and SHIFT keys, but this time combined with various special characters that Excel uses:

contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

contact@sumproduct.com
www.sumproduct.com
+61 3 9020 2071

Sydney Address:	 SumProduct Pty Ltd,  Suite 803, Level 8, 276 Pitt Street, Sydney NSW 2000
New York Address:	 SumProduct Pty Ltd, 48 Wall Street, New York, NY, USA 10005
London Address:	 SumProduct Pty Ltd, Office 7, 3537 Ludgate Hill, London, EC4M 7JN, UK
Melbourne Address:	SumProduct Pty Ltd, Ground Floor, 470 St Kilda Road, Melbourne, VIC 3004
Registered Address:	SumProduct Pty Ltd, Level 14, 440 Collins Street, Melbourne, VIC 3000

Keystroke What it does
CTRL + SHIFT + - Remove all borders

CTRL + SHIFT + , Fill down

CTRL + SHIFT + . Fill right

CTRL + SHIFT + ; Insert current time (in Edit mode)

CTRL + SHIFT + [ Select all precedent cells

CTRL + SHIFT + \ Select cells unequal to active cell

CTRL + SHIFT + ] Select all dependent cells

CTRL + SHIFT + ` General Number Format

CTRL + SHIFT + = Insert cells

There are c.550 keyboard shortcuts in Excel.  For a comprehensive list, please download our Excel file at
www.sumproduct.com/thought/keyboard-shortcuts. Also, check out our new daily Excel Tip of the Day feature on the 
www.sumproduct.com homepage.

Location Course Date Date Duration Duration

Online (Australia) Excel Tips and Tricks 5 Oct 2022 09:00-17:00 AEDT (-1 day) 22:00-17:00 GMT 1 Day

Online (Australia) Financial Modelling 6 - 7 Oct 2022 09:00-17:00 AEDT (-1 day) 22:00-17:00 GMT 2 Days

Online (Australia) Power Pivot, Power Query and Power BI 9 - 11 Nov 2022 09:00-17:00 AEDT (-1 day) 22:00-17:00 GMT 3 Days

Online (Australia) Excel Tips and Tricks 16 Nov 2022 09:00-17:00 AEDT (-1 day) 22:00-17:00 GMT 1 Day

Online (Australia) Financial Modelling 17 - 18 Nov 2022 09:00-17:00 AEDT (-1 day) 22:00-17:00 GMT 2 Days

Online (Australia) Power Pivot, Power Query and Power BI 7 - 9 Dec 2022 09:00-17:00 AEDT (-1 day) 22:00-17:00 GMT 3 Days

Online (Australia) Excel Tips and Tricks 14 Dec 2022 09:00-17:00 AEDT (-1 day) 22:00-17:00 GMT 1 Day

Online (Australia) Financial Modelling 15 - 16 Dec 2022 09:00-17:00 AEDT (-1 day) 22:00-17:00 GMT 2 Days


